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About Micriµm 

Micriµm provides high-quality embedded software components in the industry by way of engineer-friendly 
source code, unsurpassed documentation, and customer support. The company’s world-renowned real-

time operating system, the Micriµm µC/OS-II, features the highest-quality source code available for 

today's embedded market. Micriµm delivers to the embedded marketplace a full portfolio of embedded 

software components that complement µC/OS-II. A TCP/IP stack, USB stack, CAN stack, File System 

(FS), Graphical User Interface (GUI), as well as many other high quality embedded components. 
Micriµm’s products consistently shorten time-to-market throughout all product development cycles. For 
additional information on Micriµm, please visit www.micrium.com. 

About µC/µC/µC/µC/OSOSOSOS----IIIIIIII  

µC/OS-II is a preemptive, real-time, multitasking kernel.  µC/OS-II has been ported to over 45 different 

CPU architectures. 

µC/OS-II is small yet provides all the services you’d expect from an RTOS: task management, time and 

timer management, semaphore and mutex, message mailboxes and queues, event flags an much more. 

You will find that µC/OS-II delivers on all your expectations and you will be pleased by its ease of use. 

Licensing 

µC/OS-II is provided in source form for FREE evaluation, for educational use or for peaceful research.  If 

you plan on using µC/OS-II in a commercial product you need to contact Micriµm to properly license its 

use in your product.  We provide ALL the source code with this application note for your convenience and 

to help you experience µC/OS-II.  The fact that the source is provided DOES NOT mean that you can 

use it without paying a licensing fee.  Please help us continue to provide the Embedded community with 
the finest software available.  Your honesty is greatly appreciated. 
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About µC/Probe  

µC/Probe is a Windows application that allows a user to display the value (at run-time) of virtually any 

variable or memory location on a connected embedded target. The user simply populates µC/Probe’s 

graphical environment with gauges, tables, graphs, and other components, and associates each of these 
with a variable or memory location. Once the application is loaded onto the target, the user can begin 

µC/Probe’s data collection, which will update the screen with variable values fetched from the target.  

 

µC/Probe retrieves the values of global variables from a connected embedded target and displays the 

values in a engineer-friendly format.  The supported data-types are: booleans, integers, floats and ASCII 
strings. 
 

µC/Probe can have any number of ‘data screens’ where these variables are displayed. This allows to 

logically group different ‘views’ into a product. 
 

A 30-day trial version of µC/Probe is available on the Micriµm website: 

 

   http://www.micrium.com/products/probe/probe.html 
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Manual Version 

If you find any errors in this document, please inform us and we will make the appropriate corrections for 
future releases. 

Version Date By Description 

V.1.00 2007/07/02 BAN Initial version. 

 

Software Versions 

This document may or may not have been downloaded as part of an executable file, Micrium-NXP-uCOS-

II-LCD-LPC2378.exe, containing the code and projects described here.  If so, then the versions of the 
Micriµm software modules in the table below would be included.  In either case, the software port 
described in this document uses the module versions in the table below   

Module Version Comment 

µC/OS-II V2.85  

µC/Probe V1.30  

µC/LCD V3.00  
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Document Conventions 

Numbers and Number Bases 

• Hexadecimal numbers are preceded by the “0x” prefix and displayed in a monospaced font.  
Example: 0xFF886633. 

• Binary numbers are followed by the suffix “b”; for longer numbers, groups of four digits are 
separated with a space.  These are also displayed in a monospaced font.  Example: 0101 1010 

0011 1100b.  

• Other numbers in the document are decimal.  These are displayed in the proportional font 
prevailing where the number is used. 

Typographical Conventions 

• Hexadecimal and binary numbers are displayed in a monospaced font. 

• Code excerpts, variable names, and function names are displayed in a monospaced font.  
Functions names are always followed by empty parentheses (e.g., OS_Start()).  Array names 

are always followed by empty square brackets (e.g., BSP_Vector_Array[]). 

• File and directory names are always displayed in an italicized serif font.  Example: 
/Micrium/Sofware/uCOS-II/Source/. 

• A bold style may be layered on any of the preceding conventions—or in ordinary text—to more 
strongly emphasize a particular detail.  

• Any other text is displayed in a sans-serif font. 
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1.  Introduction 

This document, AN-1078, explains example code for using µC/OS-II. µC/Probe and µC/LCD with the 

NXP LPC2378 (ARM7TDMI-S) processor on the Keil MCB2300 evaluation board, shown in Figure 1.  The 
LPC2378 includes a 512-kB flash and 32-kB SRAM and operates at clock speeds as high as 72-MHz.  
Peripherals for several communications busses are provided on-chip, including UARTs, I

2
C, I

2
S, SPI, 

SSP, CAN, USB and Ethernet.  A SD/MMC card interface, a 10-bit A/D converter, a 10-bit D/A converter, 
four 32-bit general-purpose timers and up to 104 GPIOs round out the features on the chip.   

The MCB2300 has two RS-232 ports, two CAN ports, one USB port (also used for power), an Ethernet 
port and a 20-pin JTAG for debugging and loading the processor.  The interface components include one 
user push button, 8 user LEDs, a 2- x 16-character LCD, a potentiometer and a speaker. 

 

 
 
 
 
 

Figure 1-1.  Keil MCB2300 Evaluation Board 

If this appnote was downloaded in a packaged executable zip file, then it should have been found in the 
directory /Micrium/Appnotes/AN1xxx-RTOS/AN1078-uCOS-II-NXP-LPC2378 and the code files referred to 
herein are located in the directory structure displayed in Section 2.02; these files are described in Section 
3. 

The executable zip also includes example workspaces for µC/Probe.  µC/Probe is a Windows program 

which retrieves the value of variables form a connected embedded target and displays the values in an 

NXP LPC2378 Potentiometer 
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engineer-friendly format.  It interfaces with the LPC2378 via RS-232C.  For more information, including 
instructions for downloading a trial version of the program, please refer to Section 6. 

 

  
 
 
 
 
 
 
 

Figure 1-3.  µC/Probe (with Target Output Window) 
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2.  Getting Started 

The following sections step through the prerequisites for using the demonstration application described in 
this document, AN-1078.  First, the setup of the hardware will be outlined.  Second, the use and setup of 
the IAR Embedded Workbench and Keil µVision3 (RVMDK) projects will be described.  Thirdly, the steps 
to build the projects and load the application onto the board through a JTAG will be described.  Lastly, 
instructions will be provided for using the example application. 

2.01  Setting up the Hardware 

The evaluation board is powered through the USB port, marked “USB / Power” in Figure 1-1.   

As shown in Figure 2-1, the jumpers on the board should be configured for the use of the application.  The 
processor on the evaluation board can be programmed and debugged through the 20-pin JTAG port using 
a JTAG emulator, such as a J-Link (which we used for the IAR projects) or a ULINK or ULINK2 (which we 
used for the Keil µVision3 projects). 

 

Figure 2-1.  Evaluation Board Configuration 

To use µC/Probe with the LPC2378, download and install the trial version of the program from the 

Micriµm website as discussed in Section 6.  After programming your target with one of the included 
example projects, connect a RS-232 cable between your PC and the evaluation board, configure the RS-
232 options (also covered in Section 6), and start running the program.  The open data screens should 
update, as shown in Figure 1-2.  The LPC2378 example application is configured to use UART0, the RS-

232C connector labeled “RS-232 for µC/Probe” in Figure 1-1. 

Place jumper “AD0.0” 

to enable the 

potentiometer input. 

Place jumper “LED” 

to enable the LEDs. 

Place jumper “INT0” 

to enable the PB. 
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2.02  Directory Tree 

If this file were downloaded as part of an executable zip file (which should have been named Micrium-

Atmel-uCOS-II-LCD-LPC2378.exe), then the code files referred to herein are located in the directory 
structure shown in Figure 2-2.  . 

  

Figure 2-2. Directory Structure 
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Figure 2-2. Directory Structure (continued) 

2.03  Using the IAR Projects 

Two IAR projects are located in the directory (marked “IAR Example Project (with µC/Probe)” in Figure 2-
3): 

/Micrium/Software/EvalBoards/NXP/MCB2300/IAR/OS-Probe 

The first example project, MCB2300-OS-Probe-LCD.ewp, is intended for EWARM v4.4x.  To view this 
example, start an instance of IAR EWARM v4.4x, and open the workspace file MCB2300-OS-Probe-

LCD.eww.  To do this, select the “Open” menu command under the “File” menu, select the “Workspace…” 
submenu command and select the workspace file after navigating to the project directory.  The project 
tree shown in Figure 2-4 should appear.  (In addition, the workspace should be openable by double-
clicking on the file itself in a Windows Explorer window.) 

The second example project, MCB2300-OS-Probe-LCD-v5.ewp, is intended for EWARM v5.1x.  To view 
this example, start an instance of IAR EWARM v5.1x, and open the workspace file MCB2300-OS-Probe-

LCD-v5.eww.  To do this, select the “Open” menu command under the “File” menu, select the 
“Workspace…” submenu command and select the workspace file after navigating to the project directory.  
The project tree for this project will be essentially identical to the project tree for the EWARM v4.4x 
project. 

IAR EWARM Versions 

Be certain to open the proper project for your version of EWARM.  IAR EWARM v4.4x will 
NOT open a v5.1x project.  And though IAR EWARM v5.1x will open a v4.4x project, 

many errors will be generated upon compilation. 

2.03.01 Project Options 

The IAR projects are setup to compile in ARM mode.  However, both could be re-configured to generate 
16-bit Thumb instructions wherever possible, thereby reducing code size.  This setting may be changed by 

µC/Probe  
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opening the project settings dialog box.  To display this dialog box, choose the “Options” menu item from 
the “Project” menu.  The location of the configuration option within this dialog is different for EWARM 
v4.4x and EWARM v5.1x; Figures 2-3 highlight this location for both toolchain versions. 

 

 

Figure 2-3. IAR EWARM Project Tree for MCB2300-OS-Probe-LCD.ewp.   

Once the connections described in Section 2.01 are made between your PC and the MCB2300 Evaluation 
Board, the code can be built and loaded onto the board.  To build the code, choose the “Rebuild All” menu 
item from the “Project” menu.  To load the code through the J-TAG debugger onto the connected 
evaluation board, select the “Debug” menu item from the “Project” menu.  The project is setup to use a J-



 Micriµm 
µC/OS-II, µC/Probe and µC/LCD for the 

 NXP LPC2378 CPU 
 

13 

Link debugger; if you wish to use a different debugger, please select the appropriate DLL in the project 
options dialog box (select “Debugger” in the list box). 

  

Figure 2-4. Project Options:  ARM/Thumb Selection. 

EWARM v4.4x (left); EWARM v5.1x (right) 

2.03.02 µC/OS-II Kernel Awareness  

When running the IAR C-Spy debugger, the µC/OS-II Kernel Awareness Plug-In can be used to provide 

useful information about the status of µC/OS-II objects and tasks.  If the µC/OS-II Kernel Awareness 

Plug-In is currently enabled, then a “µC/OS-II” menu should be displayed while debugging.  Otherwise, the 
plug-in can be enabled.  Stop the debugger (if it is currently active) and select the “Options” menu item 
from the “Project” menu.  Select the “Debugger” entry in the list box and then select the “Plugins” tab 

pane.  Find the µC/OS-II entry in the list and select the check box beside the entry, as shown in Figure 2-

4.   

When the code is reloaded onto the evaluation board, the “µC/OS-II” menu should appear.  Options are 
included to display lists of kernel objects such as semaphores, queues, and mailboxes, including for each 
entry the state of the object.  Additionally, a list of the current tasks may be displayed, including for each 
task pertinent information such as used stack space, task status, and task priority, in addition to showing 
the actively executing task.  An example task list for this project is shown in Figure 2-5. 
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Figure 2-5. Enabling the µC/OS-II Kernel Awareness Plug-In (v4.4x) 

 

Figure 2-6. µC/OS-II Task List for MCB2300-OS-Probe-LCD.ewp 
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2.04  Using the Keil µVision3 Project 

A Keil µVision3 (RV-MDK) project file named MCB2300-OS-Probe-LCD.uV2 is located in the directory 
(marked “Keil Example Project (with µC/Probe)” in Figure 2-2) 

/Micrium/Software/EvalBoards/NXP/MCB2300/IAR/OS-Probe-LCD 

To view this example project, start an instance of Keil µVision3, and open the project file MCB2300-OS-

Probe-LCD.uV2.  To do this, select the “Open Project..” menu command under the “Project” menu and 
select the project file after navigating to the project directory.  The project tree shown in Figure 2-7 should 
appear.  (In addition, the project should be openable by double-clicking on the file itself in a Windows 
explorer window.)  

 

 

 

Figure 2-7. Keil µVision3 Project Tree for MCB2300-OS-Probe-LCD.uV2.   
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2.04.01 Project Options 

Once the connections described in Section 2.01 are made between your PC and the MCB2300 evaluation 
board, the code can be built and loaded onto the board.  To build the code, select the “Rebuild all target 
files” menu item from the “Project” menu.  To load the code through a ULINK onto the connected 
evaluation board, select the “Download” menu item from the “Flash” menu.  Finally, the LPC2378 can 
either be debugged (by choosing the “Start/Stop Debug Session” from the “Debug” menu) or allowed to 
run (by resetting the board). 

If you receive the error (or one similar) shown in Figure 2-8, then it is likely that the debug options have 
become corrupted (or have been completely reset).  Restore the settings by doing as follows (assuming 
you are using a ULINK or ULINK2): 

 

Figure 2-8.  µVision3 Error:  Incorrect Debug Settings 

1. Right-click on the target name, “Flash” in the Project Workspace and choose “Options for the 
target ‘Flash’”.  Choose the “Debug” tab in the dialog box that appears, as shown in Figure 2-9.  
Choose the proper debugger (probably “ULINK ARM Debugger”). 

 

Figure 2-9. µVision3 Debug Options 
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2. Press the “Settings” button on this tab pane.  A new dialog, as shown in Figure 2-12, should 
appear.  Match the settings as appears in Figure 2-10.  It is possible that a JTAG clock speed of 
100kHz may be too fast for either your target or your ULINK; consequently, if you have problems 
at 100 kHz, please decrease this and try again. 

 
3. Press OK in the settings dialog and switch to the “Utilities”  tab.  Select the “Use Target Driver for 

Flash Programming” radio button and select “ULINK ARM Debugger” in the drop-down menu.  
Press the “Settings” button.  A dialog should appear, as shown in Figure 2-11.  Add the 
appropriate flash loader (as has already been done in Figure 2-11) by selecting the “Add” button 
and choosing “LPC2000 IAP2 512kB Flash” in the list.  This flash loader will then appear in the list 
box in the “Flash Download Setup” dialog. 

 

Figure 2-10.  µVision3 ULINK Debugger Settings 

 

Figure 2-11. µVision3 Flash Download Settings 
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2.05  Example Applications 

The example applications contain application tasks which respond to the push button and toggle the 

LEDs.  In addition, either can be used with the Micriµm’s real-time monitor, µC/Probe, as covered in 

Section 6. 

2.05.01 Application Information 

When the example application is started, a summary of the current µC/OS-II state is displayed on the 

LCD screen (as shown in Figure 2-12).  Successive presses of INT0 will progress the LCD through a 
series of screens, shown in Figures 2-13 through 2-14.  If the push button is pressed after Screen 4, 
shown in Figure 2-15 is reached, Screen 1 will again be shown. 

Screen 2 displays the version of µC/OS-II currently running on the target and  its tick timer frequency.  

Screen three shows the percent CPU usage and CPU clock speed.  Two cumulative measures are shown 

in Screen 4:  the number of ticks and the number of context switches that have occurred since µC/OS-II 

began running.  

In addition, the LEDs will blink at a rate controlled by the potentiometer. 

 
Figure 2-12, Screen 1 

 
Figure 2-13, Screen 2:  

µC/OS-II Version Number and  Tick Rate 

 
Figure 2-14, Screen 3: 

CPU Usage and CPU Speed 

 
Figure 2-15, Screen 4:  

Cumulative Ticks and Context Switches 

 

Stack Out of Range Notification 

While debugging this project (or any other µC/OS-II project), IAR may log a SVC stack 

pointer out-of-range notification in the “Debug Log” window.  This is actually normal 

behavior and does NOT indicate an error.  IAR EWARM does not understand that the 
SVC stack pointer points to the stack for the current task stack. 
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2.05.02 Additional Application Information    

The project is configured so that code is loaded into Flash and the stacks and data are loaded into RAM, 
as shown in Table 2-1.  The tasks that run in the example application are listed in Table 2-2. 

Memory Range Size Segment(s) 

0x00000000-0x0007CFFF 500 kB Code (in Flash) 

0x40000000-0x40007FFF 32 kB Stacks and data (in RAM) 

 

Table 2-1.  Memory Setup 

Task Name Priority Function 

AppTaskKbd()  

“Keyboard” 
4 

Reads status of push button, passing new input to 
AppTaskUserIF(). 

AppTaskStart() 

“Start Task” 
5 Initializes µC/Probe; reads potentiometer input. 

AppTaskUserIF()  

“User I/F” 
7 Updates LCD. 

“uC/Probe OS” 8 Updates CPU usage for µC/Probe. 

AppTaskProbeStr()  

“Probe Str” 
9 Outputs strings to the Windows µC/Probe program. 

“Probe RS-232” 10 Parses packets from µC/Probe. 

“uC/OS-II Tmr” 29 Manages timers. 

“uC/OS-II Stat” 30 Collect stack usage statistics. 

“uC/OS-II Idle” 31 Executes when no other task is executing. 

 

Table 2-2.  Example Application Tasks 
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Figure 2-16.  Example Application Hardware Use 
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3.  Directories and Files  

Application Notes 

\Micrium\AppNotes\AN1xxx-RTOS\AN1014-uCOS-II-ARM 

This directory contains AN-1014.pdf, the application note describing the ARM port for µC/OS-II, 

and AN-1014-PPT.pdf, a supplement to AN-1014.pdf.  

\Micrium\AppNotes\AN1xxx-RTOS\AN1078-uCOS-II-NXP-LPC2378 

This directory contains this application note, AN-1078.pdf. 

Licensing Information 

\Micrium\Licensing 

Licensing agreements are located in this directory.  Any source code accompanying this appnote 

is provided for evaluation purposes only.  If you choose to use µC/OS-II in a commercial product, 

you must contact Micriµm regarding the necessary licensing. 

µC/OS-II Files 

\Micrium\Software\uCOS-II\Doc 

This directory contains documentation for µC/OS-II. 

\Micrium\Software\uCOS-II\Ports\ARM\Generic\IAR 

\Micrium\Software\uCOS-II\Ports\ARM\Generic\RealView 

These directories contain the standard processor-specific files for the generic µC/OS-II ARM port 

assuming the IAR toolchain and the ARM/Keil “RealView Microprocessor Development Kit” 
toolchains, respectively.  These files could easily be modified to work with other toolchains (i.e., 
compiler/assembler/linker/locator/debugger); however, the modified files should be placed into a 
different directory.  The following files are in this directory: 

• os_cpu.h 

• os_cpu_a.asm 

• os_cpu_c.c 

• os_dcc.c 

• os_dbg.c 

With this port, µC/OS-II can be used in either ARM or Thumb mode.  Thumb mode, which 

drastically reduces the size of the code, was used in this example, but compiler settings may be 
switched (as discussed in Section 2.30) to generate ARM-mode code without needing to change 
either the port or the application code.  The ARM/Thumb port is described in application note AN-

1014 which is available from the Micrium web site. 

\Micrium\Software\uCOS-II\Source 

This directory contains the processor-independent source code for µC/OS-II. 

µC/Probe Files 

\Micrium\Software\uC-Probe\Communication\Generic\ 

This directory contains the µC/Probe generic communication module, the target-side code 

responsible for responding to requests from the µC/Probe Windows application (including 

requests over RS-232). 
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\Micrium\Software\uC-Probe\Communication\Generic\Source 

This directory contains probe_com.c and probe_com.h, the source code for the generic 
communication module. 

\Micrium\Software\uC-Probe\Communication\Generic\OS\uCOS-II 

This directory contains probe_com_os.c, which is the µC/OS-II port for the µC/Probe generic 

communication module. 

\Micrium\Software\uC-Probe\Communication\Generic\Source\RS-232 

This directory contains the RS-232 specific code for µC/Probe generic communication module, 

the target-side code responsible for responding to requests from the µC/Probe Windows 

application over RS-232 

\Micrium\Software\uC-Probe\Communication\Generic\Source\RS-232\Source 

This directory contains probe_rs232.c and probe_rs232.h, the source code for the generic 
communication module RS-232 code. 

\Micrium\Software\uC-Probe\Communication\Generic\Source\RS-232\Ports\NXP\LPC2378 

This directory contains probe_rs232c.c and probe_rs232c.h, the NXP LPC2378 port for the RS-232 
communications. 

\Micrium\Software\uC-Probe\Communication\Generic\Source\RS-232\OS\uCOS-II 

This directory contains probe_rs232_os.c, which is the µC/OS-II port for the µC/Probe RS-232 

communication module. 

µC/OS-View Files 

\Micrium\Software\uCOSView\Source 

This directory contains the processor-independent code for µC/OS-View: 

• os_view.c 

• os_view.h 

 

\Micrium\Software\uCOSView\Ports\ARM7\LPC2378\IAR 

This directory contains the LPC2378-specific port for µC/OS-View: 

• os_viewc.c 

• os_viewc.h 

 

µC/LCD Files 

\Micrium\Software\uC-LCD\Source 

This directory contains the processor- and RTOS-independent source code for µC/LCD. 

\Micrium\Software\uC-LCD\OS\uCOS-II 

This directory contains the µC/OS-II port for µC/LCD. 

µC/CPU Files 

\Micrium\Software\uC-CPU 

This directory contains cpu_def.h, which declares #define constants for CPU alignment, 

endianness, and other generic CPU properties. 
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\Micrium\Software\uC-CPU\ARM\IAR 

\Micrium\Software\uC-CPU\ARM\RealView 

These directories contain cpu.h and cpu_a.s.  cpu.h defines the Micriµm portable data types for 8-, 
16-, and 32-bit signed and unsigned integers (such as CPU_INT16U, a 16-bit unsigned integer).  

These allow code to be independent of processor and compiler word size definitions.  cpu_a.s 
contains generic assembly code for ARM7 and ARM9 processors which is used to enable and 
disable interrupts within the operating system.  This code is called from C with 
OS_ENTER_CRITICAL() and OS_EXIT_CRITICAL(). 

µC/LIB Files 

\Micrium\Software\uC-LIB 

This directory contains lib_def.h, which provides #defines for useful constants (like DEF_TRUE 

and DEF_DISABLED) and macros. 

\Micrium\Software\uC-LIB\Doc 

This directory contains the documentation for µC/LIB. 

Application Code 

\Micrium\Software\EvalBoards\NXP\MCB2300\IAR\OS-Probe-LCD 

This directory contains the source code for the µC/OS-II, µC/Probe and µC/LCD example 

application to be used with IAR EWARM: 

• app.c contains the test code for the example application including calls to the functions 

that start multitasking within µC/OS-II, register tasks with the kernel, and update the user 

interface (the LCD and the LEDs).  app_cfg.h is a configuration file specifying stack sizes 
and priorities for all user tasks and #defines for important global application constants. 

• includes.h is the master include file used by the application. 

• os_cfg.h is the µC/OS-II configuration file.  

• MCB2300-OS-Probe-LCD-Workspace.wsp is an example µC/Probe workspace.  

• MCB2300-OS-Probe-LCD.* are the IAR EWARM v4.4x project files.  

• MCB2300-OS-Probe-LCD-v5.* are the IAR EWARM v5.1x project files.  

\Micrium\Software\EvalBoards\NXP\MCB2300\IAR\BSP 

This directory contains the Board Support Package for the MCB2300 evaluation board to be used 
with IAR EWARM: 

• bsp.c contains the board support package functions which initialize critical processor 
functions (e.g., the PLL) and provide support for peripherals such as the push button and 
LCD.  bsp.h contains prototypes for functions that may be called by the user. 

• cstartup.s79 is the IAR EWARM v4.4x startup file.  This file performs critical processor 
initialization (such as the initialization of task stacks), readying the platform to enter 
main(). 

• cstartup.s is the IAR EWARM v5.1x startup file.  This file performs critical processor 
initialization (such as the initialization of task stacks), readying the platform to enter 
main(). 

• LPC2378_Flash.xcl is a IAR EWARM v4.4x linker file which contains information about the 
placement of data and code segments in the processor’s memory map.  

• LPC2378_Flash.icf is a IAR EWARM v5.1x linker file which contains information about the 
placement of data and code segments in the processor’s memory map.  
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\Micrium\Software\EvalBoards\NXP\MCB2300\RVMDK\OS-Probe-LCD 

This directory contains the source code for the µC/OS-II, µC/Probe and µC/LCD example 

application to be used with Keil µVision3: 

• app.c contains the test code for the example application including calls to the functions 

that start multitasking within µC/OS-II, register tasks with the kernel, and update the user 

interface (the LCD and the LEDs).  app_cfg.h is a configuration file specifying stack sizes 
and priorities for all user tasks and #defines for important global application constants. 

• includes.h is the master include file used by the application. 

• os_cfg.h is the µC/OS-II configuration file.  

• MCB2300-OS-LCD-Probe.uV2 is the Keil µVision3 project file.  

\Micrium\Software\EvalBoards\NXP\MCB2300\RVMDK\BSP 

This directory contains the Board Support Package for the MCB2300 evaluation board to be used 
with Keil µVision3: 

• bsp.c contains the board support package functions which initialize critical processor 
functions (e.g., the PLL) and provide support for peripherals such as the push button and 
LCD.  bsp.h contains prototypes for functions that may be called by the user. 

• init.s performs critical processor initialization (such as the initialization of task stacks), 
readying the platform to enter main(). 

• vector.s defines the ARM exception vectors. 

• LPC2378_Flash.scat is a scatter-loading descriptor file which contains information about 
the placement of data and code segments in the processor’s memory map.  

• LPC2378_RAM.ini contains instructions that are executed prior to loading code onto the 
processor. 
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4.  Application Code  

The example application described in this appnote, AN-1148, is a simple demonstration of µC/OS-II and 

µC/Probe for the NXP LPC2378 processor on the MCB2300 evaluation board.  The basic procedure for 

setting up and using each of these can be gleaned from an inspection of the application code contained in 
app.c, which should serve as a beginning template for further use of these software modules.  Being but a 
basic demonstration of software and hardware functionality, this code will make evident the power and 

convenience of µC/OS-II “The Real-Time Kernel” used on the NXP LPC2378 processor without the 

clutter or confusion of a more complex example. 

4.01  app.c 

Five functions of interest are located in app.c: 

1. main() is the entry point for the application, as it is with most C programs.  This function 

initializes the operating system, creates the primary application task, AppTaskStart(), begins 

multitasking, and exits. 

2. AppTaskStart(), after creating the user interface tasks, enters an infinite loop in which blinks 

the LEDs at a rate determined by the potentiometer. 

3. AppTaskKbd() monitors the current state of the push buttons.  When the push button is 

pressed, this task will post a message to AppTaskUserIF(), which will change the LCD 

message.  

4. AppTaskUserIF() updates the LCD. 

5. AppTaskProbeStr() outputs strings to the µC/Probe Windows application via RS-232, which 

will appear in the Serial Output window.  For more information, see Section 6. 
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void  main (void)                                                /* Note 1 */ 
{ 
    CPU_INT08U  err; 
 
 
    BSP_IntDisAll();                                             /* Note 2 */ 
 
    OSInit();                                                     /* Note 3 */ 
 
    OSTaskCreateExt(AppTaskStart,                                  /* Note 4 */ 
                    (void *)0, 
                    (OS_STK *)&AppTaskStartStk[APP_TASK_START_STK_SIZE - 1], 
                    APP_TASK_START_PRIO, 
                    APP_TASK_START_PRIO, 
                    (OS_STK *)&AppTaskStartStk[0], 
                    APP_TASK_START_STK_SIZE, 
                    (void *)0, 
                    OS_TASK_OPT_STK_CHK | OS_TASK_OPT_STK_CLR); 
  
#if OS_TASK_NAME_SIZE > 13                                       /* Note 5 */ 
    OSTaskNameSet(APP_TASK_START_PRIO, "Start Task", &err); 
#endif 
 
    OSStart();                                                   /* Note 6 */ 
} 

Listing 4-1, main() 

Listing 4-1, Note 1:  As with most C applications, the code starts in main(). 

Listing 4-1, Note 2: All interrupts are disabled to make sure the application does not get interrupted until it 
is fully initialized. 

Listing 4-1, Note 3: OSInit() must be called before creating a task or any other kernel object, as must 

be done with all µC/OS-II applications. 

Listing 4-1, Note 4: At least one task must be created (in this case, using OSTaskCreateExt() to 

obtain additional information about the task).  In addition, µC/OS-II creates either one or two 

internal tasks in OSInit().  µC/OS-II always creates an idle task, OS_TaskIdle(), and will 

create a statistic task, OS_TaskStat() if you set OS_TASK_STAT_EN to 1 in os_cfg.h. 

Listing 4-1, Note 5: As of V2.6x, you can now name µC/OS-II tasks (and other kernel objects) and 

display task names at run-time or with a debugger.  In this case, the AppTaskStart() is given 

the name “Start Task”.  Because C-Spy can work with the Kernel Awareness Plug-In available 
from Micriµm, task names can be displayed during debugging. 

Listing 4-1, Note 6: Finally multitasking under µC/OS-II is started by calling OSSTart().  µC/OS-II will 

then begin executing AppTaskStart() since that is the highest-priority task created (both 

OS_TaskStat() and OS_TaskIdle() having lower priorities). 
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static  void  AppTaskStart (void *p_arg) 
{ 
    CPU_INT08U  i; 
    CPU_INT16U  dly; 
 
 
    (void)p_arg;                                                 
 
    BSP_Init();                     /* Note 1 */                                 
 
#if (OS_TASK_STAT_EN > 0) 
    OSStatInit();              /* Note 2 */                                       
#endif 
 
#if (uC_PROBE_OS_PLUGIN    > 0) 
    OSProbe_Init();       /* Note 3 */                                        
    OSProbe_SetCallback(AppProbeCallback); 
    OSProbe_SetDelay(50); 
#endif 
 
#if (uC_PROBE_COM_MODULE > 0) 
    ProbeCom_Init();                       /* Note 4 */                                                                 
    ProbeRS232_Init(115200); 
    ProbeRS232_RxIntEn(); 
#endif 
 
    LED_Off() 
 
    AppUserIFMbox = OSMboxCreate((void *)0);    /* Note 5 */                                             
 
    AppTaskCreate();                     
 
    dly = (ADC_GetStatus(0) >> 6) + 10; 
 
    while (DEF_TRUE) {                         /* Note 6 */                      
 
 /* Blink LEDs */         
   } 
} 

Listing 4-2, AppTaskStart() 

Listing 4-2, Note 1:  BSP_Init() initializes the Board Support Package—the I/Os, tick interrupt, etc.  

See Section 5 for details. 

Listing 4-2, Note 2:  OSStatInit() initializes µC/OS-II’s statistic task.  This only occurs if you enable 

the statistic task by setting OS_TASK_STAT_EN to 1 in os_cfg.h.  The statistic task measures 

overall CPU usage (expressed as a percentage) and performs stack checking for all the tasks 
that have been created with OSTaskCreateExt() with the stack checking option set. 

Listing 4-2, Note 3:  OSProbe_Init() initializes the µC/Probe plug-in for µC/OS-II, which maintains 

CPU usage statistics for each task. 

Listing 4-2, Note 4:  ProbeCom_Init() initializes the µC/Probe generic communication module; 

ProbeRS232_Init() initializes the RS-232 communication module.  After these have been 

initialized, the µC/Probe Windows program will be able to download data from the processor.  

For more information, see Section 6. 

Listing 4-2, Note 5:  A mailbox provides the communication between the two application tasks, 
AppTaskKbd() and AppTaskStart().  When a push button pressed, AppTaskKbd() will 
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send a message using AppKbdMbox to AppTaskStart() containing the ID of the push button.  

AppTaskStart() will change the blinking pattern of the LEDs accordingly. 

Listing 4-2, Note 6:  Any task managed by µC/OS-II must either enter an infinite loop ‘waiting’ for some 

event to occur or terminate itself.  This task enters an infinite loop in which the LEDs are toggled. 

4.02  os_cfg.h 

The file os_cfg.h is used to configure µC/OS-II and defines the maximum number of tasks that your 

application can have, which services will be enabled (semaphores, mailboxes, queues, etc.), the size of 
the idle and statistic task and more.  In all, there are about 60 or so #define that you can set in this file.  

Each entry is commented and additional information about the purpose of each #define can be found in 

Jean Labrosse’s book, µC/OS-II, The Real-Time Kernel, 2nd Edition.  os_cfg.h assumes you have 

µC/OS-II V2.83 or higher but also works with previous versions of µC/OS-II. 

• OS_APP_HOOKS_EN is set to 1 so that the cycle counters in the OS_TCBs will be maintained. 

• Task sizes for the Idle (OS_TASK_IDLE_STK_SIZE), statistics OS_TASK_STAT_STK_SIZE) and 

timer (OS_TASK_TMR_STK_SIZE) task are set to 128 OS_STK elements (each is 4 bytes) and 

thus each task stack is 512 bytes.  If you add code to the examples make sure you account for 
additional stack usage. 

• OS_DEBUG_EN is set to 1 to provide valuable information about µC/OS-II objects to IAR’s C-Spy 

through the Kernel Awareness plug-in.  Setting OS_DEBUG_EN to 0 should some code space 

(though it will not save much).   

• OS_LOWEST_PRIO is set to 31, allowing up to 32 total tasks. 

• OS_MAX_TASKS determines the number of “application” tasks and is currently set to 16 allowing 9 

more tasks to be added to the example code.  

• OS_TICKS_PER_SEC is set to 1000 Hz.  This value can be changed as needed and the proper 

tick rate will be adjusted in bsp.c if you change this value.  You would typically set the tick rate 

between 10 and 1000 Hz.  The higher the tick rate, the more overhead µC/OS-II will impose on 

the application.  However, you will have better tick granularity with a higher tick rate. 
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5.  Board Support Package (BSP) 

The Board Support Package (BSP) provides functions to encapsulate common I/O access functions and 
make porting your application code easier.  Essentially, these files are the interface between the 
application and the MCB2300 evaluation board.  Though one file, bsp.c, contains some functions which are 

intended to be called directly by the user (all of which are prototyped in bsp.h), the other files serve the 

compiler (as with cstartup.s79). 

5.01  IAR EWARM v4.4x-Specific BSP Files 

The BSP includes two files intended specifically for use with IAR EWARM v4.4x: LPC2378_Flash.xcl and 
cstartup.s79.  These serve to define the memory map and initialize the processor prior to loading or 
executing code.  If the example application is to be used with other toolchains, the services provided by 
these files must be replicated as appropriate. 

Before the processor memories can be programmed, the compiler must know where code and data 
should be placed.  IAR requires a linker command file, such as LPC378_Flash, that provides directives to 
accomplish this.  With this file, the data and execution stacks are mapped to RAM while code is mapped 
to flash. 

In cstartup.s79 is code which will be executed prior to calling main.  One important inclusion is the 

specification of the exception vector table (as required for ARM cores) and the setup of various exception 
stacks.  After executing, this function branches to the IAR-specific ?main function, in which the processor 

is further readied for entering application code. 

5.02  IAR EWARM v5.1x-Specific BSP Files 

The BSP includes two files intended specifically for use with IAR EWARM v5.1x: LPC2378_Flash.icf and 
cstartup.s.  These files serve the same purpose as their IAR EWARM v4.4x counterparts.  The linker 
specification file (extension *.icf for EWARM v5.1x) uses a completely different format than its 

predecessor (extension *.xcl for EWARM v4.4x), but the information is essentially identical.  Except for 

some minor changes to the EWARM v5.1x assembler, cstartup.s is basically identical to cstartup.s79.   

5.03  RVMDK-Specific BSP Files 

The BSP includes three files intended specifically for use with Keil µVision3 (RV-MDK) tools: 
LPC2378_Flash.scat, init.s and vectors.s The first file serves to define the memory map of the processor, 
equivalent to LPC2378_Flash.xcl for the IAR v4.4x project. 

In init.s is code which will be executed prior to calling main.  This does nothing more than setup the 

various exception stacks.  After executing, this function branches to the __main function, in which the 

processor is further readied for entering application code. 

The ARM exception vectors are defined in vector.s. 
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5.03  BSP, bsp.c and bsp.h 

The file bsp.c implements several global functions, each providing some important service, be that the 

initialization of processor functions for µC/OS-II to operate or the toggling of an LED.  Several local 

functions are defined as well to perform some atomic duty, initializing the I/O for the LED or initialize the 

µC/OS-II tick timer.  The discussion of the BSP will be limited to the discussion of the global functions 

that might be called from user code (and may be called from the example application). 

The global functions defined in bsp.c (and prototyped in bsp.h) may be roughly divided into two categories:  
critical processor initialization and  user interface services.  Three functions constitute the former: 

• BSP_Init() is called by the application code to initialize critical processor features (particularly 

the µC/OS-II tick interrupt) after multitasking has started (i.e., OS_Start() has been called).  

This function should be called before any other BSP functions are used.  See Listing 5-1 for more 
details. 

• BSP_IntDisAll() is called to disable all interrupts, thereby preventing any interrupts until the 

processor is ready to handle them. 

• BSP_CPU_ClkFreq() returns the clock frequency in Hz.   

• BSP_CPU_PclkFreq() returns the clock frequency in Hz or a peripheral clock; an ID for the 

peripheral clock (as defined in bsp.h) is accepted as the argument. 

Five function provide access to user interface components: 

• LED_Toggle(), LED_On() and LED_Off() will toggle, turn on, and turn off (respectively) the 

LED corresponding to the ID passed as the argument  If an argument of 0 is provided, the 
appropriate action will be performed on all LEDs.  The valid IDs are 1 through 8 

• PB_GetStatus() takes as its argument the ID of a push button and returns DEF_TRUE if the 

push button is being pressed and DEF_FALSE if the push button is not being pressed.  The only 

valid ID is 1. 

• ADC_GetStatus() takes as its argument the ID (on the IAR LPC2378-SK, 1) of a ADC and 

returns the 10-bit number that, when divided by 0x3FF, is equal to the ratio of the input voltage 

divided by the reference voltage. 
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5.04  Processor Initialization Functions 

void  BSP_Init (void) 
{ 
    PLL_Init();                                                 /* Note 1 */                                             
    MAM_Init();                                                 /* Note 2 */                                             
 
    GPIO_Init();                                                 /* Note 3 */    
    ADC_Init();       /* Note 4 */ 
    LED_Init();       /* Note 5 */ 
                                          
    VIC_Init();                                                    /* Note 6 */                                          
    Tmr_TickInit();                                             /* Note 7 */                                            
}                                                         

Listing 5-1, BSP_Init() 

Listing 5-1, Note 1:  The PLL is setup to generate a 72 MHz CPU clock.  All peripheral clocks are set to 
half the CPU clock. 

Listing 5-1, Note 2:  The Memory Acceleration Module (MAM) is setup. 

Listing 5-1, Note 3:  The general purpose I/O ports are setup for the LED and PB. 

Listing 5-1, Note 4:  The ADC used for the potentiometer is initialized.. 

Listing 5-1, Note 5:  The LED is initialized. 

Listing 5-1, Note 6:  The interrupt controller is initialized, including the disabling of all interrupts and the 
assignment of a dummy ISR handler to each interrupt vector to catch spurious interrupts. 

Listing 5-1, Note 7:  The µC/OS-II tick interrupt source is initialized. 

Listings 5-2 and 5-3 give the µC/OS-II timer tick initialization function, Tmr_TickInit(), the tick ISR 

handler, Tmr_TickISR_Handler().  These may serve as examples for initializing an interrupt and 

servicing that interrupt. 
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static  void  Tmr_TickInit (void) 
{ 
    CPU_INT32U  pclk_freq; 
    CPU_INT32U  rld_cnts; 
 
                                                                         
    VICIntSelect &= ~(1 << VIC_TIMER0);           /* Note 1 */                    
    VICVectAddr4  =  (CPU_INT32U)Tmr_TickISR_Handler;              
    VICIntEnable  =  (1 << VIC_TIMER0);                            
 
    pclk_freq     =   BSP_CPU_PclkFreq();                     /* Note 2 */       
 
    rld_cnts      =   pclk_freq / OS_TICKS_PER_SEC;                
 
    T0TCR         =  (1 << 1);                                      
    T0TCR         =   0;                                           
    T0PC          =   0;                                           
 
    T0MR0         =   rld_cnts;     /* Note 3 */ 
    T0MCR         =   3;                                           
 
    T0CCR         =   0;                                           
    T0EMR         =   0;                                           
    T0TCR         =   1;                    /* Note 4 */                           
} 

Listing 5-2, Tmr_TickInit() 

Listing 5-2, Note 1:  The timer interrupt vector is set and the interrupt is enabled. 

Listing 5-2, Note 2:  The peripheral clock frequency is calculated, and this clock frequency and desired 
tick rate—OS_TICKS_PER_SEC—are used to determine the number of clocks between interrupts. 

Listing 5-2, Note 3:  The timer is setup to generate a periodic interrupt and then reset to zero.   

Listing 5-2, Note 4:  The timer is started. 

 

void  Tmr_TickISR_Handler (void) 
{ 
    T0IR = 0xFF;                                /* Note 1 */                                       
 
    OSTimeTick();                                /* Note 2 */                                 
} 

Listing 5-3, Tmr_TickISR_Handler() 

Listing 5-3, Note 1:  The interrupt is cleared. 

Listing 5-3, Note 2:  OSTimeTick() informs µC/OS-II of the tick interrupt. 
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6.  µC/Probe 

µC/Probe is a Windows program which retrieves the values of global variables from a connected  

embedded target and displays the values in a engineer-friendly format.  To accomplish this, an ELF file, 
created by the user’s compiler and containing the names and addresses of all the global symbols on the 

target, is monitored by µC/Probe.  The user places components (such as gauges, labels, and charts) into 

a Data Screen in a µC/Probe workspace and assigns each one of these a variable from the Symbol 

Browser, which lists all symbols from the ELF file.   The symbols associated with components placed on 
an open Data Screen will be updated after the user presses the start button (assuming the user’s PC is 
connected to the target). 

µC/Probe currently interfaces with a target processor with a RS-232.  A small section of code resident on 

the target receives commands from the Windows application and responds to those commands.  The 
commands ask for a certain number of bytes located at a certain address, for example, “Send 16 bytes 
beginning at 0x0040102C”.  The Windows application, upon receiving the response, updates the 
appropriate component(s) on the screens with the new values.   

  

Figure 6-1. µC/Probe Windows Program 
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To use µC/Probe with the example project (or your application), do the following: 

1. Download and Install µC/Probe.  A trial version of µC/Probe can be downloaded from the 

Micriµm website at  

   http://www.micrium.com/products/probe/probe.html 

2. Open µC/Probe.  After downloading and installing this program, open the example µC/Probe 

workspace for µC/OS-II, named OS-Probe-Workspace.wsp, which should be located in your 

installation directory at 

   /Program Files//Micrium/uC-Probe/Target/Plugins/uCOS-II/Workspace 

3. Connect Target to PC.  Currently, µC/Probe can use RS-232 to retrieve information from the 

target.  You should connect a RS-232 cable between your target and computer. 

4. Load Your ELF File.  The example projects included with this application note are already 
configured to output an ELF file.  (If you are using your own project, please refer to Appendix A of 

the µC/Probe user manual for directions for generating an ELF file with your compiler.) This file 

should be in  

   /<Project Directory>/<Configuration Name>/exe/ 

 where <Project Directory> is the directory in which the IAR EWARM project is located (extension 
*.ewp) and <Configuration Name> is the name of the configuration in that project which was built 
to generate the ELF file and which will be loaded onto the target.  The ELF file will be named  

  <Project Name>.elf  

in EWARM v4.4x and  

  <Project Name>.out  

in EWARM v5.1x unless you specify otherwise.  To load this ELF file, right-click on the symbol 
browser and choose “Add Symbols”. 

5. Configure the RS-232 Options.  In µC/Probe, choose the “Options” menu item on the “Tools” 

menu.  A dialog box as shown in Figure 6-2 (left) should appear.  Choose the “RS-232” radio 
button.  Next, select the “RS-232” item in the options tree, and choose the appropriate COM port 
and baud rate.  The baud rate for the projects accompanying this appnote is 115200. 

6. Start Running.  You should now be ready to run µC/Probe.  Just press the run button ( ) to 

see the variables in the open data screens update. Figure 6-3 displays two screens in the µC/OS-

II workspace which display detailed information about each task’s state.  

 



 

Figure 6.2.  µC/Probe Options 

 

 
 

Figure 6-3.  µC/Probe Run-Time:  µC/OS-II Task Information 
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7.  µC/LCD    

µC/LCD is a software module that allows you to interface with character LCD (Liquid Crystal Display) 

modules. This software package works with just about any character module based on the Hitachi 
HD44780 Dot Matrix LCD Controller & Driver. The module allows you to:  

• Control LCD modules containing up to 80 characters; 

• Display ASCII characters; 

• Display ASCII strings; 

• Define up to eight symbols based on a 5x7 dot matrix; and 

• Display bar graphs. 
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Licensing 

µC/OS-II is provided in source form for FREE evaluation, for educational use or for peaceful research.  If 

you plan on using µC/OS-II in a commercial product you need to contact Micriµm to properly license its 

use in your product.  We provide ALL the source code with this application note for your convenience and 

to help you experience µC/OS-II. The fact that the source is provided does NOT mean that you can use it 

without paying a licensing fee.  Please help us continue to provide the Embedded community with the 
finest software available.  Your honesty is greatly appreciated.  

References 

µC/OS-II, The Real-Time Kernel, 2nd Edition 
Jean J. Labrosse 
R&D Technical Books, 2002 
ISBN 1-57820-103-9 
 
Embedded Systems Building Blocks 
Jean J. Labrosse 
R&D Technical Books, 2000 
ISBN 0-87930-604-1 

Contacts 

IAR Systems 
Century Plaza 
1065 E. Hillsdale Blvd 
Foster City, CA 94404 
USA 
 

+1 650 287 4250 
+1 650 287 4253 (FAX) 
 

e-mail:   Info@IAR.com 
WEB :   http://www.IAR.com 
 

NXP 
1110 Ringwood Court 
San Jose, CA 95131 

+1 408 474 8142 

WEB: www.nxp.com 

 

Micriµm 
949 Crestview Circle 
Weston, FL 33327 
USA 
 

+1 954 217 2036 
+1 954 217 2037 (FAX) 
 

e-mail:   Jean.Labrosse@Micrium.com 
WEB :   http://www.Micrium.com 
 
 

  

 


